
[image: image36.jpg]Sign In

GOSOLAR Home | Search for Permit | Register Help Contact Us

|» GoSolar Home | Welcome!

2 Participating Municipalities
| Register |

Welcome to GoSOLAR Online Permitting, for rooftop solar panel (photovoltaic)

» Sign In
nIn___ | cystem permitting. This system may be used to request permits for residential

» Search for or low commercial properties that are govemned by a participating  ® City of Coconut Creek

Perm municipality. « City of Dania Beach

For more information about this iniiative, visit the GoSOLAR Broward Rooftop ~ ® 10Wn of Davie

Solar Challengs website. « City of Deerfield Beach
o « City of Fort Lauderdale
Reviewing Permits o City of Hallandale Beach

« Town of Hillsboro Beach

The online database of photovoliac construction permits is searchable, | 1oy ct| o derdale by the-Sea

allowing the public to review individual permits or permit lists by date, type,

location, ctc. o City of Miramar
. . o City of North Lauderdale
Requesting Permits o City of Oakland Park

« City of Pompano Beach
o City of Sunrise
o City of Tamarac

* Use this system to choose from pre-approved and pre-engineered o Unincorporated Broward County.
solar panel mounting installation designs, and then apply for permits
using those designs.

This system provides a one-stop solar permitting process with a single
application form, electronic review and approval, and flat fee.

« OR, apply in person to request permits for installations that are NOT

typical to one of the listed and pre-approved installation designs. Baduecs

BEasratan o Florida Power and Light
« Florida Solar Energy Center

The first time you use this system to apply for @ permit, you must register.
v ” Pl for permit v ° « USS. Department of Energy

Broward Home | Terms of Use





[image: image37.png]€ GoSolar Online Permitting System - Windows Internet Explorer
&) - |2 nttps://webapps betrain cty/GoSOLAR/PermitSearch, asp

B certificate Error ||49|| X | |search results o[-

Edit View Favorites Tools Help
Google €] GOSolar Website & GOSolar Author & Gov Ops Website € Community-Wide Website € CC SharePaint i AQD Author & PPRAQ Author
Google [v] 28 search - | & share \ Mare » Signin A -

(BB 8- Brae-g

Taols +

GOSOLAR Home | Search for Permit | Register  Help Contact Us

» GoSolar Home Search for Permit
» Sign out
» Search for Filter Criteria Clear All Fiters

=
crnit i Permit Number: | Permit Holder:
» My Permits
» Permit List address: Job Title:

e Jurisdiction: Al ] Issued Betweer

» Request Next Status: Al ] Expires Between:
Inspection
» My Account

» Update Update List

Information

» Change.
Password

per:

n Per:

Holder Job

le Status Issue Date

Number _Address/Juri
2801 N Ocean Blvd

12-00017 P N — esued 10/01/2012
1200013 EE customer test John Doe's Residence lasued 09/10/2012
1200012 B2ammenst customer, st 4 asued 0712772052
1200011 432 Johnson st customen test test esued 0712372012
|12-00010 432 Johnson St. customer, test QA Test Issued 07/23/2012

Town of Davie

Broward Home | Terms of Use

® 90 L 100%




www.broward.org/gogreen/gosolar
Disclaimer

“This guide was prepared as an account of work sponsored by the United States Department of Energy.  Neither the United States Government nor any agency thereof, nor any of their employees, makes any warranty, express or implied, or assumes any legal liability or responsibility for the accuracy, completeness, or usefulness of any information, apparatus, product, or process disclosed, or represents that its use would not infringe privately owned rights.  Reference herein to any specific commercial product, process, or service by trade name, trademark, manufacturer, or otherwise does not necessarily constitute or imply its endorsement, recommendation, or favoring by the United States Government or any agency thereof. The views and opinions of authors expressed herein do not necessarily state or reflect those of the United States Government or any agency thereof.”
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1. Introduction 
The Broward County Go SOLAR Online Permitting System Web application is intended for use by contractors who represent homeowners and business owners seeking to install solar rooftop photovoltaic (PV) systems in Broward County, Florida.  The Go SOLAR Online Permitting System Web application address is: www.gosolar.broward.org.  An example of the website home page is below.
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Jurisdiction: City of Coconut Creek

Permit Number GOSOLAR 12-00020

Permit Statu: Issued

Property Address: 11 Main Street, Coconut Creek, FL 33067
Owner: Laurie Thomas

Project Title Laurie Thomas

To request an inspection, fillin any necessary information and then click the button to submit the request.

Optionally, you may request that the inspection be scheduled for a particular date and time. You may also enter a
comment below, for the inspector to see.

An inspector will contact you to schedule the inspection date and time.
INSPECTIONS: Monday through Friday (except holidays) between 8:00 AM and 3:00 PM.

Inspection Type Electrical - rough

Inspection Date: [ [ Time: [~ Not specified - v

Customer Comment ‘ J
Notice of Commencement: Must be posted at the job site

If required, the NOC must be posted before the first inspection.
Click here for information about the Notice of Commencement.

Submit Inspection Request





DISCLAIMER:  Web page examples included in this document are for the purpose of illustration.   The actual Web Page contents may be slightly different than what is shown in this document.

2. Who Should Use The Go SOLAR Online Permitting System? 
A series of questions was developed to determine who should use the Go SOLAR Online Permitting System.  For help deciding whether or not the Go SOLAR Online Permitting System can be used for your permit application, go to the GoSolar home page and select the “Should I use this site?” option listed under the “Help” menu.
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You may use the system to apply for a permit if the answer is “yes” for all of the questions on that page.

[image: image2.jpg]Should I use this system to request my permit?

Use this system to request your permit if you can answer "Yes" to ALL of the questions below.
[]  Do1have a valid contractor's license?
s the permit for installation of a rooftop solar panel system?

o
[] Wil the system be installed for a residential or low commercial structure?
(]

Is the property where the system will be installed within the jurisdiction of one of the

participating agencies? <-- List of P v
Will the system be installed on one of the pre-approved
O roof structure types? <~ List of Roof Structure Types > v
For this installation, can I use one of the pre-engineered, pre-approved solar panel
O structural designs? <~ List of Pre-approved Structural Designs —> v
an this system be installed using one of the pre-engineered, pre-approved
O etectrical connection designs? [[<— List of Electrical Designs > vl
Does the system to be installed MEET EVERY ONE of thes technical, electrical specifications?
O [<List of Electrical Requirements —> v
[] 1 the %) adobe® Reader® software installed on my computer so that T can open the PDF (portable document
format) design documents that the system wilprovide?
[] Dol have access to a printer in order to prnt the Permit Card that must be generated through this system and
then posted at the construction site?
[J  Will 1 use one of the credit cards listed here to pay online? | <-- Accepted Credit Cards > v
[ Contractors: Do I have 3 valid license and the required Workers' Compensation and liabiity insurance?
[0 Contractors: Do I have the appropriate type of license to request this permit? | < Allowed Licenses --> v |
All Yes
1 have a user account. 1do ot have a user account.
[___Signonto ApplyforPermit___| [ Request an Account

1f the answer to any of these questions is "No", please contact the appropriate agency directly.




3. User Registration 
Before using the system to request a PV system permit, select the “Register” option from the left navigation menu and follow the instructions to set up a user account.  All items followed by an asterisk (*) are required.

[image: image3.jpg]Register

To apply for a permit, you must complete this registration process one time, to set up an account.

© 1f you already registered, then sign in.
 If you registered but forgot your password, then click here to reset your password.
 If you requested an account but did not receive the confirmation email, enter your

User Name here: and then click here to re-send the email.

To create a new account for permitting purposes, please enter all of the required information below, then click the button
to Register. Items with an asterisk (*) are required.

om— —
Password:* 1
|

Name (First/Middle/Last): | Il ]

Aot 15 I ]

Address Line 2 (if any)

[
City/State/Z1P* FL v

e e T
Email Address:* I ]
Securily festion EE—— B

ey Ausenet® I ]

Only licensed contractors may use this system. For assistance, please contact the appropriate agency.

Contractor Information

Company Name:* I ]

Qualifier Name (required if other ]

than permit holder)

DR e |~ Gromes o> Bl AR e

Contractor License Number

oty suraries Compzcy | ]

Policy Number:* | | Expiration Date:* | s

Workers' Comp. Insurance
Company:

et | e

Type the characters displayed in the images below. The
characters should appear in English. If they are difficult to
read or appear in another language, refresh.

267

Type he o words: c
o ({ ReCAPTCHA™
I e,

Please review all the above information for accuracy before registering for an account. Any.
misrepresentations here may cause your access to this system to be revoked.

Register as Contractor





4. Applying for a New Permit 

Sign in with the user name and password you selected during registration: 
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Sign In

User Name:

Password

Don't yet have an account?
Forgot your password?




To start a new permit application, select the “Apply for New Permit” option from the left navigation menu.
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The Terms of Use page is the first page of the permit application process. In order to proceed with the application, read and agree to the terms of use.
[image: image6.jpg]Apply for a New Permit

Terms of Use > Property > Owner

Roof > System

Terms of Use

‘Application is hersby made to obtain 3 permit to do work and installation as indicated. I certify that no
work or installation has_commenced prior to the issuance of a permit and that all work will be
performed to meet the standards o al laws regulating construction in this jurisdiction. I understand
that 2 separate permit must be secured for ELECTRICAL WORK, PLUMBING, SIGNS, WELLS, POOLS,
FURNACES, BOILERS, HEATERS, TANKS, and AIR CONDITIONERS, etc.

s a condition to applying for and receiving a building permit, as a contractor you must show proof and
certify that you have Workers' Compensation for employees or Workers' Compensation exemption,
under the chapter as provided in Florida Statute 440.10 and 440.38.

WARNING TO OWNERS: YOUR FAILURE TO RECORD A
NOTICE OF COMMENCEMENT MAY RESULT IN YOUR PAYING
TWICE FOR IMPROVEMENTS TO YOUR PROPERTY. A NOTICE
OF COMMENCEMENT MUST BE RECORDED AND POSTED ON
THE JOB SITE BEFORE THE FIRST INSPECTION. IF YOU
INTEND TO OBTAIN FINANCING, CONSULT WITH YOUR
LENDER OR AN ATTORNEY BEFORE COMMENCING WORK OR
RECORDING YOUR NOTICE OF COMMENCEMENT. CHAPTER
2007.221 LAWS OF FLORIDA FS.713.135(1)(a).

Click here for more information about the Notice of Commencement.

The applicant confirms that if they are not the owner of the real property subject to attachment, then
as a condition to the issuance of the building permit, the applicant promises, in good faith, to deliver
the statement above to the owner of the real property.

By clicking "I Agree”, you agree to these terms of use.




The second step is to enter the property information for the permit you are requesting.
[image: image7.jpg]Apply for a New Permit
Terms of Use > Property > Owiier > Project > Roof > Syster > Review > Pay

Property Information

Below, please describe the property for which you are requesting a permit, then dlick the button
t6 0 {0 the next step. ltems with an asterisk (*) are required.

Please use the Property Appraiser Web site to look up or confirm information about the property.

If the permitting authority for the property is not listed here, you cannot use this system to apply
for this permit and must contact the appropriate agency directly.

Jurisdiction: * [<-MotSelectes > v]

Street Address: © | ]

Address Line 2 [ ]
[

awfsme/zes [ N[
LR [Broward

Folio Number: |

| or parceim:

Legal Description: * | ]

Building Use: O Low Commercial Oresidential

Save and go to Next Step




The third step is to enter property owner information for the permit you are requesting.
[image: image8.jpg]Apply for a New Permit
Terms of Use > Property > Owner > Job > Roof > System > Review > Pay

Property Owner Information

Please provide information about the owner of the property for which you are requesting a permit.
After supplying all required information, dlick the button to o to the next step. ltems with an
asterisk (*) are required.

Owner Name:*

Address Line 1:*

G /state/zies =

Phone Number:*

[
[
Address Line 2 I
[
o s [

| other phone: ]

me[ ]

Email Address: I ]

Fee Simple Titicholder (if other than owner)

Titleholder Name:

Address Line 1

Address Line 2:

City/state/z1P

SRy I

it Addese I ]

Mortgage Lender

Lender Name:

Address:

Address Line 2

[
[
[
City/State/ZIP [

@l





The fourth step is to enter project information for the permit you are requesting.

[image: image9.jpg]Apply for a New Permit
Terms of Use > Property > Owner > Project > Roof > System > Review > Pay

Project Information

Please provide the information requested below, to describe the project for which you are requesting a
permit. After supplying all required information, click the button to go to the next step. Ttems with an
asterisk (*) are required.

Project Title:* [

Project Description:

Project Value (US$):*
Kilowatt Capacity (DC kW):* v

Bonding Company (if any)

Company Name:

Address Line 2 (if any)

[
e ot I
[
[

City/State/2IP:

Save and go to Next Stef




Then, select the option indicating the type of roof on which the PV system will be installed.
[image: image10.jpg]Apply for a New Permit

indicate the type of roof structur  panels will

structure type is not listed, please contact the appropriste
stem to apply for the permit.

Metal hingle
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Finally, select the pre-approved design plans that will be used for the project.  Save your information and proceed to the next step.
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Pre-approved Systems and Plans

Please indicate which preapproved design options will be used for this project by selecting the correct values

below, If the designs you will be using are not listed here, please contact the appropriate agency directly and
do not use this system to apply for the permit.

Roof Structure Type: | Kilowstes:

Structural Design: * | <~ Not Selected —>

Electrical Design: * | Electrical Design Example 1 B view desian

X¥Z Engineering Company
1 North University Drive, Suite 40034, Plantation, FL 33324





After you save your information, you will be directed to the “Permit Application Summary” page.  Verify that all of the entered information is accurate and complete.  Then, read the affidavit and select the “Confirm and Continue” button.

[image: image12.jpg]Apply for a New Permit
Terms of Use > Property > Owner > Project > Roof > System > Review

Permit Application Summary

Please review the information you entered and make any necessary corrections.

Pay

City of Coconut Creek
4500 West Copans Road), acr2, Cocont Creek, FL 33063

|Building Use:
Property Ouner
|Name:

Mailing Address:
Phone Number:
Email Address:

Project Information
Title:

Project Value:
Kilowatts (DC k)

Solar System Information
Roof Structure Type:

Structural Design:

| Electrical design:

Permit Fee $500.00
BORA Surcharge 24.00
F.S.468.631 Surcharge 7.50
F.S.553.721 Surcharge 7.50
Total Permit Fees:  $539.00
Bank Convenience Fee $13.74
Total Payment Due:  $552.74
| Contractor
|Name: System Administrator
Company Name: asd
Mailing Address: 1 N. University Drive, Plantation, FL 33324
Phone Number. 954-765-4400 x9800
License: sdf
Property Edit
Address: x, X, FL 33333
Legal Description: 3
Folio Number:3 parcel 1d

Low Commercial
Edit
X

X X, FL33333
999-933-5955

Edit

$1.00
3.00

Edit
Barrel Tile

IE] sounting choice x for 3k systern
X¥Z Engineering Company
1 North Universty Drive, Suite 40034, Plantaton FL 33324

Electrical Desian Example
XYZ Engineering Company.
1 North University Drive, Suite 40034, Plantation, FL 33324,

AFFIDAVIT:

certify that all the foregoing information is accurate and that all work will be done in
compliance with all applicable laws regulating construction and zoning.

The Building Official may revoke a permit or approval issued under the provisions of this Code in case of any
false statement or misrepresentation of fact in the application o on the plans and/or specifications on which
the permit or approval was based.

CJ___Confirm and Continue___'>




The next step is payment.  Enter valid credit card information to pay for the permit application.

[image: image13.jpg]Apply for a New Permit
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Credit Card Payment

To complete the application process and receive your permit, p lease use a credit card to make your payment
now. Permit fees must be paid in full and in U.5. Dollars only. No partial payments are accepted. Fields in bold
are required.

Permit Information

Customer Name: Test Customer
Project Title: Rooftop PV on 13 residence
Total Amount Due: $552.74

Billing Information

This information will only be used for the purpose of authorizing this transaction.

First Name: | |

Last Name:

Street Address: | |
Address Line2: [
city:
State/Province: | SELECT a STATE, PROVINCE. or REGION |
Zip/Postal Code: e

Counts

[United States

Daytime Phone #:

Email Address: [ | (for receipt)

Credit Card Information

Card Type: SELECT a CREDIT CARD v
Card Number: | No dashes needed
Expiration Date: 01 v|/[2012 v

Please enter your name as it appears on the card.

e |
Name:

Security Code:

For Visa, MasterCard, and Discover, use the 3-
digit number located on the back of the card near
the signature line. For American Express use the
4-digit number located above the card number.

Fees are non-refundable.

PAY NOW






After the payment is accepted, you will receive payment confirmation.  Within the payment confirmation page you can also view and print your permit documents and design plans:
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» Request Next

» Update
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» Design
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b Settings

Payment Confirmation

Thank you for your payment. A confirmation email has been sent to the email
address that you specified.

The permit described below has now been issued.

Please print this message for your records,

Payment Date: 11/28/2012 4:16 PM
Payment Confirmation Number: 0XXXXA
Payment Amount: $552.74

Permit Issued

Jurisdiction: City of Coconut Creek
Permit Number: 12-00037

Permit Holder Name: Test Customer

Job Title: Rooftop PV on 1] residence
What now?

» You must print the permit documents shown below, and post them at the
job site:

B permit card tructural Design

& permit document Electrical Design

» You may also visit the page to REVIEW the permit details,

- Is the EPL net metering application complete? The FPL net metering
agreement must be submitted and the meter must be changed before the
system is energized other than for testing and inspection

» When you have finished reviewing and printing your permit, SIGN OUT for
now, and then come back to this system when the job is ready for the first
inspection.

WARNING TO OWNERS: YOUR FAILURE TO RECORD A
NOTICE OF COMMENCEMENT MAY RESULT IN YOUR PAYING
TWICE FOR IMPROVEMENTS TO YOUR PROPERTY. A NOTICE
OF COMMENCEMENT MUST BE RECORDED AND POSTED ON

THE JOB SITE BEFORE THE FIRST INSPECTION. IF YOU

INTEND TO OBTAIN FINANCING, CONSULT WITH YOUR
LENDER OR AN ATTORNEY BEFORE COMMENCING WORK OR
RECORDING YOUR NOTICE OF COMMENCEMENT. CHAPTER

2007.221 LAWS OF FLORIDA FS.713.135(1)(a).





You may view and print your Permit Card:

[image: image15.jpg]City of Coconut Creek, Florida

BrowardRooftop Solar Online Permitting

BUILDING PERMIT

PERMIT NO. PURPOSE DATE
[GoSOLAR 1200037 | [Solar Panel |[i1r8r012 |

OWNER ADDRESS
[loe And Jane @ Owner |23 N Wain st

CONTRACTOR LICENSE NO.
[TestCustomer |3

LEGAL DESCRIPTION
[Cot 1 block1

'WARNING TO OWNER: YOUR FAILURE TO RECORD A NOTICE OF
COMMENCEMENT MAY RESULT IN YOUR PAYING TWICE FOR
IMPROVEMENTS TO YOUR PROPERTY. A NOTICE OF
COMMENCEMENT MUST BE RECORDED AND POSTED ON THE JOB
SITE BEFORE THE FIRST INSPECTION. IF YOU INTEND TO OBTAIN
FINANCING, CONSULT WITH YOUR LENDER OR AN ATTORNEY
BEFORE RECORDING YOUR NOTICE OF COMMENCEMENT

INSPECTION RECORD

Inspection Date Inspector Comments
1. Structural-progress

2 Electrical —rack grounding

3. Electrical—rough

4.Structural—final

5. Electricalfinal

DO NOTREMOVE THIS CARD BEFORE COMPLETION.

FORINSPECTION, VISIT WWWBROWARD ORG/GOSOLAR OR CALL 954-973-6770
Monday through Friday (except holidays)between 800 AM and 300 PM.




You may also view and print your official Permit Document and design plans:

[image: image16.jpg]City of Coconut Creek, Florida

Broward Rooftop Solar Online Permitting

Visit www.broward.org/GoSOLAR to schedule inspections.

Property Address: 123 N. MAIN ST. Permit No.: GOSOLAR 12-00037
COCONUT CREEK, FL 33333 Issue Date: 11/28/2012
Folio Number: 12345 Total Fee:  $539.00

Legal Description: LOT 1 BLOCK 1

Application Description: ROOFTOP PV ON 1] RESIDENCE
Valuation: $12,345.67

Owner: Contractor:

JOE AND JANE Q. OWNER TEST CUSTOMER
321 MICHIGAN AVE X

MIAMI BEACH, FL 33333 432 JOHNSON ST.

HOLLYWOOD, FL 33123
054-765-4400
License: x

Permit Issued by: Jack Boone
Authorized Permit Officer

WARNING TO OWNER: YOUR FAILURE TO RECORD A NOTICE OF
COMMENCEMENT MAY RESULT IN YOUR PAYING TWICE FOR
IMPROVEMENTS TO YOUR PROPERTY. A NOTICE OF
COMMENCEMENT MUST BE RECORDED AND POSTED ON THE JOB
SITE BEFORE THE FIRST INSPECTION. IF YOU INTEND TO
OBTAIN FINANCING, CONSULT WITH YOUR LENDER OR AN
ATTORNEY BEFORE RECORDING YOUR NOTICE OF
COMMENCEMENT.

A copy of the NOC must be provided prior to any inspection.

TIME LIMITATION (FBC 104.9.3.1): Permit shall expire and become null and void if work is not
commenced within 180 days from the date of issuance of this permit, or if such work when
commenced is suspended or abandoned for a period of 90 days.

INSPECTIONS: Monday through Friday (except holidays) between 8:00 AM and 3:00 PM

All Plans and documentation must be on the job before inspections will be made. Note: If the
volume of inspections is large, your inspection may roll over to the next day.




5. Permit Search Options 
To find or review existing permits in the system, use the "Search for Permit" menu option at the top of the page.  When a customer is signed on to the permit system, the “Show only my permits” box is initially checked to show only the current user’s permits.  That box may be unchecked, and other search options may be adjusted, to view any or all permits in the system.
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If you start applying for a new permit but do not finish the application process, the incomplete application is listed as a “Draft”.  To resume work on an incomplete permit application, select the draft permit number. To delete an incomplete application from the system, select the delete symbol ([image: image18.png]


) next to that permit number.
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To review the details of an existing permit, select the appropriate permit number from the Permit List.
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Once you select the permit you want you will be able to view the permit details:

[image: image20.jpg]Town of Davie
Permit Number: GoSOLAR 12-00031

Issued: 11/28/2012  Expires: 05/27/2013 Permit Fees: $539.00

Acknowledgment: Pending
Last Updated:  11/28/2012 10:44 AM by Qa Test

Status: Issued

Contractor
Name: Qa Test

Company Name: Qat test

Mailing Address: 1 Univ Dr, Plant, FL 22222

Phone Number: ss5-111-1111

Email Address: testtestu@broward.org

License 222222222222

Property

Address: 1 test rd, Sun, FL 44444

Folio Number: 2222 Parcel 1d: 2555
Legal Description misc

Building Use Low Commercial

Property Owner

Name: Jane Doe.
Mailing Address: 6 solar dr, Sunny, FL 44444
Phone Number: 666-663-6555

Email Address:

Project Information

Title: sac project
Project Value: $400.00
Kilowatts (DC K): 3.00

Solar System Information
Roof Structure Type: Concrete

structural Design = tounting choice x for 3 e svstem

302 Engineeting Company

¥ North Univrsty Drve, Suite 40034, Plantaton FL 39326
tecrical dsion [ P

XYZ Engineering Company.
1 North University Drive, Suite 40034, Plantation, FL 33324

Inspections
Inspection Type Requested Inspected Result e
1 Structursl - progress | | I |
e T I I I
3|Electrical - rough | | |
4[Structural - final I I I
|Electrical - final I I I

- I the FEL net metering application complete? The FPL net metering agreement must be submitted and

the meter must be changed before the system is energized other than for testing and inspection.






6. Requesting Inspections 
Once your permit has been issued, you can request an inspection.  Use the “Search for Permit” feature described above to find the permit for which you want an inspection.  Review the inspection information at the bottom of the Permit Detail page, and select the type of inspection you are requesting from the “Inspection Type” list.  Note that the final inspection can only be requested after all other inspections have been completed.
[image: image21.jpg]Roof Structure Type: Barrel Tile

structura! Design ] 210 arrav, 2 i - exposure Cateaorv ¢
Cartaya & Associates Architects, P.A.
3077 £ Commercial Blvd, Suite 201, Ft. Lauderdale, AK 33308

lectrica desion [ stinge 20 modtes
Marco Perez, P.E., Broward County
L N. University Drive, Plantation, AK 33324

permitdocuments:  Heermicarg [ sermit document

Inspections

Inspection Type Requested Inspected
Structural - progress.

1
2|Electrical - rack grounding
3|Electrical - rough
2
s

Structural - final

Electrical - final

B 1Is the FEL net metering application complete? The FPL net metering agreement must be subrmitted and
the meter must be changed before the system is energized other than for testing and inspection.




Follow the instructions on the Permit Inspection page to send an inspection request to the appropriate agency.  Please note the following:

1. Inspections are conducted by the authorized agent of the local city or municipality that has jurisdiction over the property where the PV system will be installed.
2. You may indicate a preferred date and time for an inspection; however, it is ultimately the city/municipality authorized agent who will confirm the date and time of the inspection.  The city/municipality authorized agent will contact you.   


After the inspection request is submitted, an email with the request is automatically forwarded to the appropriate city or municipality and the permit inspection information is updated accordingly in the permitting system:
[image: image22.jpg]permitdocuments:  Heemicarg et document

Inspections

Inspec
Structural - progress. 09/13/2012

n Type Requested Inspected Result Fee

Electrical - rack grounding

Structural - final

1
2|
3|Electrical - rough
2
s

v

B 1Is the FEL net metering application complete? The FPL net metering agreement must be submitted and
S R Tt D Thnond Defores te Codber b rn ot than Ty ko Arih ateetisn:




When the inspection is completed, you will receive an email message similar to the example shown below. 
[image: image23.jpg]From: noreply-GoSOLAR @broward.org. Sent: Wed9/19/20128:27 ¢
o

Subject GoSOLAR Inspection Completed

GoSOLAR Inspection Completed

The inspection described below was completed.

iInspection Type: Structural - progress
Inspection Dat: 09/18/2012 i
Inspection Result: Passed !
iInspector Name: Inspector Smith
Inspector Comment: Good job. :
Durisdiction: City of Dania Beach
Permit Number: GOSOLAR 12-00015 :
iPermit Holder Name System Administrator i

Please sign in to the system to access your permit and inspection information at any time:
https:/iwebapps betrain.ctv/GoSOLAR Role Customer/Inspection.aspx?Inspectiond=376

Note: If the link above s not working, please copy the entire link text and paste that text into
your browser




Select the link within the email you receive to log on to the online permitting system and then view the permit inspection information.  The system will be updated to indicate the date the inspection was completed and the result of the inspection.
[image: image24.jpg]permitdocuments:  Heemicarg et document

Inspections

Inspection Type Requested Inspected
Structural - progress. 09/12/2012 09/15/2012 passed

1
2|Electrical - rack grounding
3|Electrical - rough
2
s

Structural - final

B 1Is the FEL net metering application complete? The FPL net metering agreement must be submitted and
S R Tt D Thnond Defores te Codber b rn ot than Ty ko Arih ateetisn:




If re-inspection is necessary because an inspection was not approved, a re-inspection fee may be assessed. Both the email notification and online permitting system “Permit Detail” page will include that information.  Outstanding fees must be paid before other inspections may be requested.

[image: image25.jpg]From: ‘nareply-GoSOLAR @broward.org Sent: Wed 9/19/20
To:
Subject: GOSOLAR Inspection Completed

GoSOLAR Inspection Completed

The inspection described below was completed

inspection Typ Structural - progress
Inspection Date:  09/18/2012
Inspection Result:  Disapproved
inspector Name:  Inspector Wilson

inspector Comment: Third inspect

n attempt - reinspect

hurisdiction: City of Coconut Creek
Permit Number:  GOSOLAR 12-00007
iPermit Holder Name: d Contract

Inspection Fee Due: $50.00

P i i s S e Al v e AR e S A i




To pay the fee, select the “Balance Due – click here to pay” option on the Permit Detail page.  Selecting this option will re-direct you back to the Credit Card Payment page of the system.

[image: image26.jpg]Permit Detail

ity of Coconut Creek

Permit Number: GoSOLAR 12-00007

Issued: 06/20/2012 Expires: 03/18/2013 Permit Fees: $539.00
Last Updated: 09/19/2012 9:30 AM by System Administrator

Balance Due - click here to pay: $50.00

Status: Issued

Contractor

Name: Licensed Contractor

Company Name: 2 company

Mailing Address: 1 n main st., Plantation, AK 33324
Phone Number: 954-765-4400




When the “click here to pay” option is selected for a re-inspection fee, a summary of the amount due is shown:

[image: image27.jpg]Balance Due Summary

Payment is now due for the fees listed below.

Town of Davie
6591 Orange Drive, Davie, FL 33314

Inspection Fee $50.00
Total Fees: $50.00
Bank Convenience Fee $2.00
Total Payment Du $52.00
Permit Number: GoSOLAR 12-00010
Issusds 07/23/2012  Expires: 04/11/2013
Custorner Narme: Test Customer
Project Tite o Test
Property Owner: Customer, Test
Property Address 432 Johnson St., Hollywood, FL 33123
Inspection Type Requested __Inspected __ Result Fee
S Structurs! - inal lowza/zniz  [10/11/2012 | Disapproved 450.00

Go To Payment Page





Select the “Go to Payment Page” option and then enter valid credit card information to pay for the re-inspection fee.

[image: image28.jpg]Credit Card Payment

P lease use a credit card to make your payment now. Permit fees must be paid in full and in U.S. Dallars anly
No partial payments are accepted. Fields in bold are required

Permit Information

Permit Number: GOSOLAR 12-00010
Gustomer Name: Test Customer
Project Title: QA Test

Total Amount Due: $52.00

Billing Information

This information will only be used for the purpose of authorizing this transaction.

First Nam

Last Name:




.  .  .

[image: image29.jpg]Security Code: 123

For Visa, MasterCard, and Discover, use the 3-
digit number located on the back of the card near
the signature line. For American Express use the
4-digit number located above the card number.

Fees are non-refundable.

PAY NOW





7. Final Inspection 
Once the final inspection is approved, the status of the permit changes to “Complete” and all the permit information remains in the system indefinitely, for future reference.

[image: image30.jpg]Permit Detail
Search Again

City of Coconut Creek
Permit Number: GoSOLAR 12-00020

Issued: 07/05/2012  Expires: 01/08/2013 Permit Fees: $539.00
Last Updated: 07/12/2012 5:04 PM by Test Admin

Contractor
Name Laurie Thomas

Company Name: Broward County.

Mailing Address: 11 Heron Bay Bivd, Deerfield Beach, AK 33076
Phone Number: 6545181276

License 11223344

Property

Address: 11 Main Street, Coconut Creek, FL 33067

Folio Number: 0215-01-0130 Parcel Id: 504215010130
Legal Description Lot 1 Block 7

Building Use Residential

Property Owner

Name Laurie Thomas.
Mailing Address: 11 Main Street, Coconut Creek, 33067
Phone Number: 9545230313

Email Address:

Project Information
Title: Laurie Thomas.

Project Value: $23,000.00

Number of Solar Panels: 12 Kilowatts (DC Kn): 2.50





8. Questions 

For questions about the online permitting system and/or application process, select the “Contact Us” option on the top menu and then contact the appropriate city/municipality listed on that page.
[image: image31.jpg]Online Permitting System

roward Rooftop Solar Challenge
GOSOLAR Home | Search for Permit = Register = Hel

'
» GoSolar Home Welcome! T
» Register
= Welcome to GoSOLAR Online Permitting, for rooftop solar panel (photovoltaic)
| eSignIn | Syctem permitting. This system may be used to request permits for residential
» Search for or low commercial properties that are governed by a participating  ® City of Coconut Creek
Permit municipality. « City of Dania Beach

For more information about this intiative, visit the GoSOLAR Broward Rooftop ~ ® 10Wn of Davie

Solar Challenge website. o City of Deerfield Beach
X o City of Fort Lauderdale
Reviewing Permits o City of Hallandale Beach

« Town of Hillsboro Beach

The online database of photovoliac construction permits is searchable, | 1o ct| oy derdale by the-Sea

allowing the public to review individual permits or permit lists by date, type,

location, ete. « City of Miramar
) . « City of North Lauderdale
Requesting Permits o City of Oakland Park

« City of Pompano Beach
o City of Sunrise
o City of Tamarac

* Use this system to choose from pre-approved and pre-engineered o Unincorporated Broward County.
Solar panel mounting installation designs, and then apply for permits
using those designs.

This system provides a one-stop solar permitting process with a single
application form, electronic review and approval, and flat fee.

« OR, apply in person to request permits for installations that are NOT

typical to one of the listed and pre-approved installation designs. Eaiinecs

Regisation o Florida Power and Light
« Florida Solar Energy Center

The first time you use this system to apply for a permit, you must register.
” Z PEYERS AT & « US Department of Energy

Broward Home | Terms of Use





[image: image32.png]Contact Us

For questions regarding this program, please contact one of the participating agencies.

Agency Email Phone
City of Sunrise smilhausen@sunrisefl.gov,

10770 West Oakland Park Boulevard dbenedict@sunrisefl.gov, 954-746-3230
Sunrise, FL 33351 Imarks@broward.org

City of Tamarac

6011 Nob Hill Road, First Floor. permitgtamarac.org 954-597-3420
Tamarac , FL 33321

Unincorporated Broward County. dpustizzi@broward.org,

1 n university dr, bldb b Imarks@broward.org, 954-765-4400 x9800

Plantation, FL 33324 dolinn@broward.org




Appendix A – Florida Power & Light Net Metering and Interconnection
From the Go SOLAR Online Permitting System, applicants will be able to apply for FPL’s Net Metering Program by submitting an Application for Interconnection and an Interconnection Agreement.  Applications for Interconnection and Interconnection Agreements can be submitted to FPL once you have received your permit from the Go SOLAR Online Permitting System.  
FPL’s Application for Interconnection and the Interconnection Agreement can be obtained by selecting and following the “FPL Net Metering Application” hyperlink on either the Payment Confirmation page, or the bottom portion of the Permit Detail page of the Go SOLAR Online Permitting System.

[image: image33.jpg]Payment Confirmation

Thank you for your payment. A confirmation email has been sent to the email
address that you specified.

The permit described below has now been issued.

Please print this message for your records,

Payment Date: 11/28/2012 4:16 PM
Payment Confirmation Number: 0XXXXA
Payment Amount: $552.74

Permit Issued

Jurisdiction: City of Coconut Creek
Permit Number: 12-00037

Permit Holder Name: Test Customer

Job Title: Rooftop PV on 1] residence
What now?

» You must print the permit documents shown below, and post them at the
job site:

B permit card Structural Design
& permit document Electrical Design

B You may also visit the page to REVIEW the permit details

S the EPL net metering application completsZ.dde FPL net metering
agreem Tiater must be changed before the

system is energized other than for testing and inspection

B When you have finished reviewing and printing your permit, SIGN OUT for
now, and then come back to this system when the job is ready for the first
inspection.

WARNING TO OWNERS: YOUR FAILURE TO RECORD A
NOTICE OF COMMENCEMENT MAY RESULT IN YOUR PAYING
TWICE FOR IMPROVEMENTS TO YOUR PROPERTY. A NOTICE
OF COMMENCEMENT MUST BE RECORDED AND POSTED ON

THE JOB SITE BEFORE THE FIRST INSPECTION. IF YOU

INTEND TO OBTAIN FINANCING, CONSULT WITH YOUR
LENDER OR AN ATTORNEY BEFORE COMMENCING WORK OR
RECORDING YOUR NOTICE OF COMMENCEMENT. CHAPTER

2007.221 LAWS OF FLORIDA FS.713.135(1)(a).




[image: image34.jpg]Town of Davie
Permit Number: GoSOLAR 12-00031

Issued: 11/28/2012 Expires: 05/27/2013 Permit Fees: $539.00

Acknowledgment: Pending
Last Updated:  11/28/2012 10:44 AM by Qa Test

Status: Issued

Contractor
Name Qa Test

Company Name: Qat test

Mailing Address: 1 Univ Dr, Plant, FL 22222

Phone Number: ss5-111-1111

Email Address: testtestu@broward.org

License: 222222222222

Property

Address: 1 test rd, Sun, FL 44444

Folio Number: 2222 Parcel 1d: 2555
Legal Description misc

Building Use: Low Commercial

Property Owner

Name: Jane Doe.

Mailing Address: 6 solar dr, Sunny, FL 44444

Phone Number: 666-663-6555

Email Address:

Project Information

Title: sac project
Project Value: $400.00
Kilowatts (DC K): 3.00

Solar System Information
Roof Structure Type: Concrete

StuciliDesg Mounting choice X for 3 kW system

XYZ Engineering Company.
1 North University Drive, Suite 40034, Plantation, FL 33324

— B ot
XV2 Engineering Company
¥ Nrth Universty Drve, St 40034, Plantaton FL 39326

Inspections

on Type Requested Inspected Result
progress |

Fee

2|Electrical - rack grounding

a[Structural - final

|

| |

S \ |
\ \

| |

5| Electrical - final

Is the F2L net metering application complete? TPk FPL net metering agreement must be submitted and
. must be changed before th  eneraized other than for testing and inspection.





FPL has three Interconnection Application Tiers.  Most rooftop PV installations fall under a “Tier One” application category (0 – 10 kW projects).  FPL’s Net Metering website explains detailed information about FPL’s Net Metering Program and the 3 separate Interconnection Tiers: www.fpl.com/netmetering.  
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